[bookmark: _GoBack]





[image: ViewPlus Logo]

ViewPlus IVEO Creator 2.0 and Creator Pro 2.0 Manual
Revision: 20100209






























Table of Contents


[bookmark: TOC_1_Introduction]I.   Introduction 
[bookmark: TOC_1_A_Preface]A.  Preface 
[bookmark: TOC_1_B_Specifications]B.  Specifications 
[bookmark: TOC_2_Command_Overview]II.   Command Overview 
[bookmark: TOC_2_A_File_Menu]A.  File Menu 
[bookmark: TOC_2_B_Edit_Menu]B.  Edit Menu 
[bookmark: TOC_2_C_Add_Menu]C.  Add Menu 
[bookmark: TOC_2_D_View_Menu]D.  View Menu 
[bookmark: TOC_2_E_Barcodes_Menu]E.  Barcodes Menu 
[bookmark: TOC_2_F_Speech_Menu]F.  Speech Menu 
[bookmark: TOC_2_G_Show_Menu]G.  Show Menu 
[bookmark: TOC_2_H_Window_Menu]H.  Window Menu 
[bookmark: TOC_2_I_Touchpad_Menu]I.  Touchpad Menu 
[bookmark: TOC_2_J_Help_Menu]J.  Help Menu 
[bookmark: TOC_3_Using_IVEO_Creator_Pro_Tools]III.   Using IVEO Creator Pro Tools 
[bookmark: TOC_3_A_Using_IVEO_Converter_to_Create_a]A.  Using IVEO Converter to Create an IVEO SVG document 
[bookmark: TOC_3_B_Importing_a_Scanned_Image]B.  Importing a Scanned Image 
[bookmark: TOC_3_C_Importing_a_Bit-map_Image]C.  Importing a Bit-map Image 
[bookmark: TOC_3_D_Editing_Text]D.  Editing Text 
[bookmark: TOC_4_Support]IV.   Support 
[bookmark: TOC_4_A_Support]A.  Support 







[bookmark: 1_Introduction]I. Introduction
[bookmark: 1_A_Preface]A.   Preface
Welcome to IVEO - a hands-on learning system that combines touch, sound and sight to make learning more engaging and complete for all students while also including tools necessary for people with visual or learning disabilities. With IVEO you can view existing graphics or create your own! 
 
The IVEO system consists of three software components and one hardware component:
 
Software: 
· IVEO Viewer: View existing IVEO files - download the Viewer free.
· IVEO Creator: Create your own interactive files directly in IVEO Creator or using Adobe Illustrator, CorelDRAW, Microsoft Visio or any other program that exports to SVG.
· IVEO Creator Pro: Import PDF files or scan in printed materials using IVEO's advanced OCR technology. Create your own interactive files directly in IVEO Creator Pro, convert existing graphics into interactive IVEO files or use your favorite graphics program with IVEO Converter to import your own designs. 
Hardware:
· IVEO Touchpad - a touch-sensitive pad for reading tactile-audio images. IVEO touchpads connect through USB and are available in two sizes - Standard: 11x14; Portable: 9x12.5.
 
Keep up to date by checking the ViewPlus Technologies, Inc. web site at:
http://www.ViewPlus.com
 



[bookmark: 1_B_Specifications]B.   Specifications
	Operating System 
	Windows XP/2000

	CPU     
	Pentium 1 GHz or better

	Memory
	512 MB or more

	Display resolution 
	800x600 or more

	Hard drive use
	up to 350 MB of free space







[bookmark: 2_Command_Overview]II. Command Overview
[bookmark: 2_A_File_Menu]A.   File Menu
· New (Ctrl+N): Opens a page setup dialog allowing the user to specify the page settings desired for the new file. The new file is created when the OK button on the dialog is activated.
· Open (Ctrl+O): Opens up a dialog box allowing the user to choose what SVG file to open.
· Reload (Ctrl+L): Reopens the current file.
· Open from barcode (Ctrl+B): Allows the user to open a file by placing a page embossed from IVEO Creator or Viewer onto the Touchpad and pressing the three points along the top edge of the page when directed. Bar code and index callback works on files printed on that same computer. If the files and the bar code library file in which the printout parameters are recorded are all copied to another computer, call back will work on the second computer also.
· Open from index (Ctrl+I): Allows a user to open a file by typing in the index number embossed in Braille on a page by a ViewPlus embosser.
· Import (no hot key): Allows the user to import bit-map (*.bmp) and portable document (*.pdf) files into IVEO Creator and run them through the optical character recognition (OCR) engine in one step. *Available with Creator Pro only.
· Scan (no hot key): Allows the user to scan images directly into IVEO using any scanner installed on the user's system. Text OCR is done automatically. *Available with Creator Pro only.
· Save (Ctrl+S): Saves a file under the same name and file type it currently has.
· Save As (Ctrl+A): Saves the current view of a file. A new name and/or file type can be chosen using this command.
· Page Setup (no hot key): Allows the user to select printing options, including the page width and height, portrait or landscape print mode, vertical and horizontal margins.
· Print (Ctrl+P): Prints or embosses the current file.
· Recent (no hot key): Opens a drop down menu listing recent files in chronological order. One may be opened by selecting it.
· Preferences (no hot key): Allows the user to change user interface language, units of measurement, Braille font used for embossing page labels, pointer size, change zoom and pan command step sizes, change shape drawing segment length and toggle the print to log file feature on and off. Users can choose different menu and screen views. The Windows file dialog option, fixed screen mode and the 'Accessibility View' is recommended for people with severe print disabilities. The font parameters for the status bar may be changed, and people using self-voicing can choose not to self-voice the print dialog, which is automatically spoken by screen readers. The Emboss Frame option permits fiducial frame corners as well as tactile bar code and index information to be added by ViewPlus embossers. The Emboss Text as Pattern option will permit a hooked line to be embossed in place of graphical text. The Emboss Standard Text option allows the user to turn standard text embossing off completely. Other options on the screen include a drop-down box used for selecting the resolution of imported images and checkboxes for turning the show links and navigate links options on and off.
· Scan and Import Preferences (no hot key): Allows the user to set preferences for Creator's scanning and import features. Options include checkbox toggles for embedding original images, inserting rectangles over text, per character text positioning and segmented images recognition. Error factor values and precision factor values may be set by typing in numerical values or using the up and down arrow keys. There are also combo boxes for selecting the image resolution and the OCR language. *Available with Creator Pro only.
· Exit (Alt+F4): Closes the Creator. 



[bookmark: 2_B_Edit_Menu]B.   Edit Menu
· Undo (Ctrl+Z): Allows user to undo previous action. This useful tool lists the name of the action just taken, so the user can determine what will be changed.
· Redo (Ctrl+Y): If the user edits with the undo and wants to return to the previous view, clicking on this function will go back to the previous view. 
· Edit Element Properties (Alt+Enter): Allows the user to edit the currently-selected element's attributes, including the title and description text fields. The text in the title field is read by the program when the element is selected. The text in the description field is read when a user selects 'Say Selection.' There are also options to add or remove links to files or sounds on this screen. Other element properties may be edited by selecting the advanced tab.
· Edit Document Description (no hot key): Allows the user to edit the document description. The document description is voiced each time the file is opened.
· Edit Element Geometry (Shift+Enter): Allows the user to edit the geometry of the element according to the rules for drawing that type of element.
· Repair Text (no hot key): Checks the text of the current file and repairs errors. This is needed for SVG files made by converting PDF, Visio, and possibly other graphic files having embedded fonts. *Available with Creator Pro only.
· Delete Selected Element (Ctrl+Shift+Delete): Deletes the selected element.
· Duplicate Selected Element (Ctrl+Alt+D): Copies the selected element.
· Duplication Properties (no hot key): Allows the user to control the insertion position of duplicated elements.
· Convert to Overlay (Ctrl+Shift+O): Converts the selected element to an overlay element so that objects behind it may be seen through it.
· Select Text (Ctrl+T): Allows the user to more easily locate text by increasing the pointer size to search for text only. After choosing this option, the user should touch near where the text is believed to be and continue touching until the program reads the text. The text is now selected.
· Select Elements (Ctrl+E): Allows the user to select multiple elements at once.
· Copy Element Attributes (no hot key): Imports the fill and line properties of the next element selected.
· Find Element (F3): Assists the user in locating an element tactually. A dialog box opens in which the user can select the element he or she wishes to find. The user then presses anywhere on the Touchpad and the IVEO program directs the user which way to move his or her finger to reach the element. When the user has touched the element, it becomes selected and the IVEO program states that the element has been found.
· Move Selected Objects (no hot key): Allows the user to click on an element and move the element to a new location. To move several elements at the same time, click on the first element, hold down the Control (Ctrl) key and click on any additional elements. All the elements should have a box around them and may be moved.
· Rotate Selected Objects (no hot key): Allows the user to click on an element and rotate it.
· Scale Selected Objects (no hot key): Allows the user to click on an element and change the size. Drag the corner to maintain the same shape. To enlarge one dimension, use one of the points on the side of the element and drag the side until the element is the desired size.
· Arrange (no hot key): Opens a drop down menu allowing the user to change the order of elements on the screen. Choices are:
· Move Forward (Ctrl+X) - Moves the selected element forward one level.
· Move to Front (Ctrl+Alt+X) - Moves the selected element in front of all other elements.
· Move Backward (Shift+X) - Moves the selected element backward one level.
· Move to Back (Shift+Alt+X) - Moves the selected element behind all other elements.



[bookmark: 2_C_Add_Menu]C.   Add Menu
· Text (Ctrl+Shift+T): Switches to add text mode. Adds text elements one at a time until the space bar is pressed.
· Rectangle (Ctrl+Shift+R): Switches to rectangle mode. Allows the user to add any number of rectangles as separate elements. Rectangle mode continues until the space bar is pressed.
· Oval (Ctrl+Shift+V): Switches to oval mode. Adds ovals, one at a time, which become separate elements. Oval mode can be ended by pressing space.
· Polyline (Ctrl+Shift+P): Switches to polyline mode. Allows the user to draw freeform lines which then become separate elements. Polyline mode continues until the space bar is pressed. Among other uses, the polyline option may be used for adding signatures to documents to be printed.
· Filled Polyline (Ctrl+Shift+L): Switches to filled polyline (or filled freeform shape) mode. Filled polyline mode can be ended by pressing the space bar.
· Polygon (Ctrl+Shift+G): Switches to polygon mode. Allows the user to click two points to draw a straight line and continue clicking to draw additional straight lines connected to the end point of the last straight line. A polygon can be finished by pressing the space bar.
· Curve (Ctrl+Shift+C): Switches to curve mode. Allows the user to draw curves by clicking a starting point, two curve points and an ending point. Until the space bar is pressed, a continuous string of curves can be drawn.
· Image (Ctrl+Shift+I): Allows the user to add a .jpeg or .png image to an SVG file.
· Selection Mode (Space): Brings the user out of Add Menu modes and allows the user to once again select elements to hear them read.



[bookmark: 2_D_View_Menu]D.   View Menu
· Fit to Window (Ctrl+Page Up): Places the full figure in its original size along the left edge of the window.
· Fit Selection to Window (Ctrl+Shift+Page Up): Fits the outer dimensions of the selected element to the outer dimensions of the screen so that either the length or width of the selected element matches the corresponding dimension of the window.
· Zoom Rectangle (Shift+Page Up): Allows the user to select two points diagonal from each other, defining a rectangle. The rectangle will then behave as an element selected for the 'Fit Selection to Window' command. When accessibility mode is used, users are asked to confirm points with the spacebar.
· Zoom In (Page Up): Increases the size of the image so that more detail can be viewed.
· Zoom Out (Page Down): Decreases the size of the image.
· Pan Left (Crtl+Shift+Left arrow): Moves the entire image farther to the left of the screen.
· Pan Right (Ctrl+Shift+Right arrow): Moves the entire image farther to the right of the screen.
· Pan Up (Ctrl+Shift+Up arrow): Moves the entire image farther up on the screen.
· Pan Down (Ctrl+Shift+Down arrow): Moves the entire image farther down on the screen.
· Next Page (no hot key): Moves to the next page in a multiple page document.
· Previous Page (no hot key): Moves to the previous page in a multiple page document.
· Go To Page (no hot key): Moves to selected page.



[bookmark: 2_E_Barcodes_Menu]E.   Barcodes Menu
· Open Barcode Library (no hot key): Opens a bar code library, making it the currently active library for recalling images from bar code or index.
· Save Barcode Library As (no hot key): Saves currently active bar code library with a different name and/or in a different location. Library is updated to reflect any change in location.
· Recent Barcode Library (no hot key): Shows list of recent bar code libraries, permitting one in the list to be selected to change currently active library.
· Edit Barcode Library (Ctrl+Shift+B): Permits bar code library to be edited. A table shows the index number, the file name and an optional title and description for each entry.
· Tab moves from table to the various buttons and back. Arrows move across rows and up/down columns.
· Press Ctrl+E or Alt+Enter to open an entry for editing. Press Esc to escape without saving changes, Enter to exit and save changes. Full path name is shown when entering file.
· Ctrl+O opens currently selected file, but focus stays in edit dialog.
· Ctrl+Delete deletes current row.
· Ctrl+S sorts entries by data in current column.



[bookmark: 2_F_Speech_Menu]F.   Speech Menu
· Toggle Speech (Ctrl+Alt+S): Turns speech off if it is currently on or on if it is currently off.
· Speech Settings (Ctrl+Shift+S): Opens a dialog box which allows the user to change the Creator's voice to any voice installed on the user's system. Users can also use the speech settings function to change the speed or pitch of the speech. A test button is available on the dialog box so that users may hear the speech produced by their choice of settings before applying it.
· Say Selection (Ctrl+D): Causes the IVEO application to read the title and description fields of the currently selected element. When text is selected, this command causes the entire text element to be read.  Typically, text elements in graphics are a single word or group of words forming a label. The element could be a line or even a full paragraph for standard text, so Ctrl+D typically reads more than just the text that is selected.
· Say Document Description (D): Causes the IVEO application to read the description field of the document.



[bookmark: 2_G_Show_Menu]G.   Show Menu
· Accessible User Interface (Shift+A): Toggles user into Accessible User Interface when in Standard Interface and vice versa. Accessible User Interface turns on space bar confirmation when entering points while performing certain operations such as opening from a barcode, calibration and zoom rectangle commands, as well as adjusting other options for better accessibility.
· Elements List (Shift+E): Displays the graphics element tree of the current file.  Elements can be selected and edited using this command.
· Document Viewer (Shift+V): Displays the element tree of the current file and allows users to group, ungroup and edit elements in a standard file tree view.
· Select Color (Shift+C): Allows the user to change fill and line properties of existing elements or to set the properties desired for elements he/she plans to draw. Alterable properties include fill or line presence, color and opacity and line width.
· Speech Overview (F2): Opens a dialog box that displays the last 25 spoken items. Useful for reviewing long descriptions and checking spelling of words.
· Toolbar (no hot key): Shows or hides the Creator toolbar. Hiding prevents accidental activation by blind users.
· Links (F9): Shows or hides pink boxes around elements which have links.
· Navigate Links (Ctrl+F9): Toggles link navigation. When active, links are activated when a user clicks on an element. When not active, Creator voices the element title when an element is clicked.
· Overlays (F8): Shows or hides overlay elements. When active, overlays are displayed as light blue elements. When not active, overlays are not displayed.



[bookmark: 2_H_Window_Menu]H.   Window Menu
· Restore: Returns the window to its original size from its maximized size.
· Minimize: Minimizes the Creator window so that it only appears as an icon in the Windows task bar.
· Maximize: Maximizes the Creator window so that it fills the whole screen.
 



[bookmark: 2_I_Touchpad_Menu]I.   Touchpad Menu
· Touchpad Settings (no hot key): Allows the user to select the type of touchpad in use and set parameters for touchpad. The user may specify maximum and setup paper sizes and settings for the selected touchpad. The user may also review the list of supported paper sizes for the active touchpad, add new paper sizes or edit the stored properties of current paper sizes, including the name, height and width of the paper, page orientation and margin settings.
· Calibrate from Current Image (Ctrl+U): Allows the user to calibrate the screen display to the touchpad by touching the top left and lower right frame corners of the current image on the IVEO Touchpad.
· Print Calibration Pattern (no hot key): Print calibration pattern for calibrating screen display to IVEO Touchpad - alternative to calibrating with an image made from some file.
· Calibrate from Calibration Pattern (no hot key): Calibrates screen display from calibration image on IVEO Touchpad.
· Print Initial IVEO Touchpad Setup Pattern (no hot key): Prints pattern for initial setup of IVEO Touchpad. See Touchpad setup instructions.
· Perform Initial Setup of IVEO Touchpad (no hot key): Opens screen for user to perform initial setup of IVEO Touchpad. See touchpad setup instructions.



[bookmark: 2_J_Help_Menu]J.   Help Menu
· About (no hot key): Displays the opening splash screen, which gives software information including the version number and user license number.
· Help (F1): Brings up this manual.
· Touchpad Help (no hot key): Brings up the TouchPad manual.
· Online Help (Ctrl+F1): Brings up a link to the ViewPlus support page from which one can obtain online tutorials and other support for IVEO Creator and Viewer.
· Check for Updates (no hot key): Checks for IVEO software updates. If an update is available, the user is notified and is given the choice of whether to install the update. 





[bookmark: 3_Using_IVEO_Creator_Pro_Tools]III. Using IVEO Creator Pro Tools
[bookmark: 3_A_Using_IVEO_Converter_to_Create_an_IV]A.   Using IVEO Converter to Create an IVEO SVG document
Creator Pro users can print to IVEO Converter to create an SVG file from any Windows application. This is the recommended procedure even for applications such as Visio, Adobe Illustrator, CorelDraw, etc. that can export as SVG. SVG files in general can have problems with sizing, text and element structure that are minimized by IVEO Converter. One simply clicks on print, selects the IVEO Converter (which is installed during Creator Pro installation) and prints. A dialog box permits users to select the name and location of the output.
 
The output will be a file _index.html and a file folder called _index_files. Here is the name given to the output when printing to IVEO Converter. An SVG file for each page printed is contained in the file folder and is called xxx.svg where xxx is the page number. A single page document will be 001.svg. This structure is convenient for creating web documents with multiple page SVG documents. Users who don't need to use this capability may delete the html file, move the SVG files out of that folder and delete the folder if desired. Files may be renamed of course, e.g. by deleting the 001 from single-page SVG files.
 
The SVG file will be exactly what would be printed on a standard printer, including margins. Consequently it will sometimes be desirable to change the page layout so images fill the entire page. Extra white space is normally undesirable. However one can select the part of the image that is desired and click on "Fit Selection to Window" in the View menu. Blind users can do this by making a copy of the original and then selecting "Zoom rectangle" in the View menu, and then selecting opposite corners of the image. Once this maximized image has been defined, use the Save As command to save it, or print it and recall it later by its tactile bar code or index.
 
Text is generally reproduced very well if created in most Windows applications. However if text is present as bit-map images, the text will be images in the SVG document and will not be read as text. Images containing bit-mapped text should be selected, copied to some graphics authoring program, saved as a png or tif file and then imported into IVEO Creator. When bit maps are imported, text is automatically subjected to OCR (Optical Character Recognition) and is usually accurately converted to "real" SVG text. Microsoft Paint, the utility that comes as part of Windows, can be used to capture an image saved to the clipboard. Paint then permits exporting the image in a number of formats.
 
PDF documents can be converted to SVG, but users should be warned that PDF files may need some special attention. Many PDF documents are images with no real text. They may be saved from Acrobat as a png or tiff file and those bit map files imported into Creator Pro. The text will then be OCR'ed. Many PDF files with real text embed the fonts and use internal coding to identify the characters. When IVEO Converter is used to convert such files, the text will read nonsensically in IVEO Creator Pro, Creator or Viewer because the internal coding of the text characters can result in mis-identification of characters. However such mis-identification can be repaired with the Repair Text menu item in the Creator Pro Edit menu. Some other graphic authoring applications also convert with occasional incorrectly-identified text. These errors can also be repaired with the Repair Text Creator Pro function.



[bookmark: 3_B_Importing_a_Scanned_Image]B.   Importing a Scanned Image
To import from a scanner, the user should be sure that the scanner is properly installed, place the desired document on the scanner (best results are obtained when the document is oriented correctly), then select and click on the Scan menu item in the IVEO Creator Pro file menu. The user is then led through the standard options of the particular scanner, and then the document is scanned into Creator Pro. After scanning is complete, Creator Pro will announce that OCR (Optical Character Recognition) is in progress. The time needed for the OCR process depends on the speed of the user's computer but is typically a few seconds. Text recognition is generally excellent for standard documents scanned at a resolution of 400 dpi or more. 200 dpi is the minimum recommended for OCR. Accuracy is reduced if characters are very small, if the copy is not sharp (e.g. FAX copies and poorly photocopied materials), if foreign or scientific characters are present, or if fancy formatting, multicolors, etc. are present as text or background to text. Text that has been incorrectly identified can be edited following procedures described in Section D below.



[bookmark: 3_C_Importing_a_Bit-map_Image]C.   Importing a Bit-map Image
Several standard bit-map formats may be imported into IVEO Creator Pro. Click the Import menu item in the File menu and select the file to be imported. JPG, PNG, TIFF images may be imported, but GIF images are not accepted due to proprietary claims on this format. However one may convert GIF files to other formats using Microsoft Paint. PNG is recommended.
 
The bit map files are automatically OCR'ed and imported into an SVG file. In order to keep the size of the SVG file as small as feasible, the bit map file is referenced and used when displaying in IVEO Creator Pro, Creator or Viewer. Consequently the bit map image should always be moved along with the SVG file if the file is moved.  
 
Most bit map files made by scanning or copying within Windows applications are likely to import well, but many web bit maps may not. Web authors commonly reduce the file size of images for efficiency, and these can give quite strange results when imported and OCR'ed. It is common to give very small "thumbnail images" intended mostly as a link to something more interesting. These small files seldom import well, so users are encouraged to find larger, better resolution images.



[bookmark: 3_D_Editing_Text]D.   Editing Text
The Repair Text item in the Edit menu can only correct the character code of characters, not the screen image of the character. If OCR mistakes have been made, the screen image shows the character that the OCR engine has selected to represent the original image, and Repair Text can have no effect. Consequently one must Edit Text if an OCR error has been made. One should also edit text if a word is broken into two or more text spans instead of being (and reading as) a single word when selected.
 
When one selects a text element, one may open the Edit Text dialog with ALT ENTER or by clicking the Edit Element Properties item in the Edit menu. A list of words in that text element is given on screen along with several buttons. One may arrow up and down the text word list until one finds the word to be edited. Select it with ALT ENTER or by double-clicking the mouse. Edit, then click OK or press ENTER to accept the edited word, or click cancel or press ESC to cancel editing without making any change. One edits split words by expanding one part to the full word and deleting the other. Delete a word by editing it and deleting the characters with DEL or BACKSPACE.
 
Click the Advanced button to edit other properties such as position, font, etc. The full SVG text parameters may be edited by people who understand how to use this powerful editing capability.





[bookmark: 4_Support]IV. Support
[bookmark: 4_A_Support]A.   Support
Tutorials and other support materials are available on the ViewPlus website. For these resources and other support inquiries, please visit ViewPlus Support online.


Additional training and support is available for purchase through your authorized ViewPlus distributor or from ViewPlus Technologies.
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